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Resumen 

Se ha realizado un estudio en el campo de dolinas de los Llanos de Cupierlo (Huesca) con 

intención de conocer su evolución y sus características. También se ha tratado de conocer cuál es 

la mejor metodología a seguir utilizando SIG.  

Se han comparado ortofotos de 1956 y 2018 para conocer la evolución. Se han 

comparado archivos MDE de 5 y 1 metro de resolución de pixel. Se ha utilizado el MDE de 1 metro 

de resolución para conocer distintos parámetros de las dolinas: área dolinizada, densidad, índice 

de distribución espacial, pendiente, red de drenaje y orientación. Se ha utilizado bibliografía para 

conocer la geología de la zona. 

Se observa crecimiento de número y área de dolinas, aunque la metodología utilizada se 

cree que no es conveniente. Los resultados obtenidos mediante la digitalización en el MDE de 1 

metro son más precisos. Se obtiene un porcentaje de dolinización del 8,85 % y una densidad de 

31,72 dolinas/km2. La distribución de las dolinas en los Llanos es aleatoria. La orientación de las 

dolinas es NE-SO, coincidente con fallas presentes. El campo se ha generado debido a la escasa 

pendiente, al clima frío y lluvioso, y a la naturaleza caliza de la zona. 

 

 

Palabras clave: 

MDE, ortofotos, dolinización, LIDAR. 
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Abstract 

A study has been carried out in the sinkhole field of the Llanos de Cupierlo (Huesca) with 

the intention of knowing its evolution and its characteristics. Also tried to know which is the best 

methodology using GIS applications. 

Orthophotos from 1956 and 2018 have been compared to know their evolution. 5 and 1 

meter pixel resolution DEM files have been compared. The 1 meter resolution DEM has been used 

to know different parameters of the sinkholes: dolinized area, density, spatial distribution index, 

slope, drainage network and orientation. Bibliography has been used to know the geology of the 

area. 

There is a growth in sinkholes number and area, although the methodology used is 

believed to be inappropriate. The results obtained by digitizing in the 1 meter DEM are more 

accurate. A dolinization percentage of 8.85% and a density of 31.72 sinkholes/km2 are obtained. 

The distribution of sinkholes in the Llanos is random. The orientation of the sinkholes is NE-SW, 

coinciding with faults present. The field has been generated due to the low slope, the cold and 

rainy climate, and the limestone nature of the area. 

 

 

Keywords: 

DEM, orthophotos, dolinization, LIDAR. 
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1. Introducción 

Los Llanos de Cupierlo, situados en el Parque Natural de la Sierra y Cañones de Guara, en 

la provincia de Huesca, han sufrido un gran modelado kárstico, dando lugar al mayor campo de 

dolinas de todo Aragón. Si bien existen otros campos de dolinas a nivel autonómico tanto en 

calizas como en evaporitas, el campo de dolinas de los Llanos de Cupierlo es único por su 

ubicación en altura, su elevada densidad de dolinización y es el de mayores dimensiones de la 

provincia de Huesca (Gracia, 1987; Chueca, 1990). A pesar de que esta zona ya fue estudiada por 

Rodríguez Vidal e incluida en su Tesis Doctoral en 1983, contiene numerosas preguntas todavía 

sin responder referidas tanto a la distribución espacial y temporal  como a los procesos genéticos 

implicados. Este trabajo busca la caracterización de este campo de dolinas, y conocer por qué 

aparecen en esta zona. Para ello resulta muy útil el uso de herramientas SIG (Sistemas de 

Información Geográfica), ya que permiten la obtención de un buen número de variables para 

poder caracterizar la zona y realizar un seguimiento de su evolución. Estas aplicaciones son 

especialmente útiles en lugares inaccesibles o de difícil acceso como es el caso de la presente 

zona de estudio, la cual se encuentra a 3 horas andando del lugar de aparcamiento. Existe un gran 

número de herramientas SIG a disposición del público, como mapas, ortofotos o modelos digitales 

de elevaciones (MDE) que permiten obtener información muy interesante sobre distintos 

parámetros geométricos (orientación, área, volumen, dirección del eje mayor y menor…), 

distribución espacial o evolución de las dolinas. Esta información se obtiene a través de distintos 

procesos realizados mediante aplicaciones como QGIS o ArcMap. Con el paso del tiempo, los SIG 

han ido perfeccionando sus herramientas. Una de estas evoluciones en las herramientas SIG es la 

capacidad de obtener archivos MDE con resoluciones más altas, lo que permite la obtención de 

datos mucho más precisos. A modo de ejemplo, en la Figura 1 se muestra la diferencia de una 

dolina en un MDE de 5 metros de resolución y en otro de 1 metro.  
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Figura 1: Comparación entre una dolina en MDE con 5 metros (izquierda) y 1 metro de 

resolución (derecha). Fuente: Elab. propia. 

 

Como puede observarse, la diferencia entre ambas resoluciones es considerable. En la 

digitalización de estas dolinas, esta diferencia es muy significativa ya que puede dar datos 

distintos en posteriores procesos para su caracterización, como en el cálculo de áreas u 

orientaciones.  

Utilizando la tesis de Rodríguez Vidal (1983) como base fundamental de este estudio, se 

cree conveniente el análisis de esta zona mediante tecnología más moderna, ya que exceptuando 

esta tesis, los estudios en la zona son escasos o nulos. Además, utilizando los estudios de Gracia 

(1987) y Chueca (1990), se ha realizado una comparación entre campos de dolinas para conocer 

las características de las dolinas de la zona de estudio.  

1.1 Karst y dolinas 

Se conoce como Karst a una forma de relieve de distintas características debido a la 

disolución de las rocas subyacentes. Por lo general, el modelado kárstico afecta principalmente a 

rocas calizas y a rocas evaporíticas, aunque también puede darse en rocas sedimentarias y 

metamórficas de composición mayormente carbonatada (Gutiérrez, 2001). 

El constituyente principal de las rocas calizas es el carbonato de calcio (CaCO3), el cual es 

poco soluble en agua pura (16 mg/l a 16oC de temperatura). Sin embargo, este compuesto 

reacciona con los ácidos. En la naturaleza, la combinación de CO2 con H2O da lugar a formación de  

ácido carbónico (H2CO3), el cual sí reacciona con el carbonato cálcico para formar bicarbonato de 

calcio (Ca(HCO3)2), que es soluble y fácilmente transportable por el agua. De este modo, su 

solubilidad varía entre 80 y 350 mg/l en función del contenido en CO2. Como todos los gases la 
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solubilidad del CO2 disminuye conforme aumenta la temperatura y en consecuencia, la solubilidad 

de la caliza es mayor a bajas temperaturas (Galán, 1991). 

Una de las principales formaciones exokársticas son las dolinas, también llamadas 

sinkholes, que se definen como  depresiones cerradas  en superficie relacionadas con la disolución 

en profundidad de materiales carbonatados o evaporíticos para formar cavidades cuyos techos 

flexionan o colapsan. Estas formaciones muestran una gran variedad de formas, así como de 

tamaños (Gutiérrez, 2001). 

Atendiendo a la morfología de las dolinas, éstas se pueden clasificar en los siguientes 

tipos (Cvijic, 1983; Sweeting, 1972): 

- En artesa o cubeta: Son los tipos de dolinas más frecuentes. Tienen fondos cubiertos 

por material insoluble. La relación diámetro/profundidad es de 1/10, y el ángulo de la 

vertiente es de 10°. 

- En embudo: Estas dolinas poseen fondos cubiertos de detritos, en los cuales pueden 

aparecer conos de subsidencia. El fondo también puede ser plano, debido a los 

procesos de evolución de la ladera. Estas dolinas poseen un diámetro mayor que la 

profundidad.  

- En pozo o ventana: Son dolinas con paredes muy verticales, en las que la profundidad 

es mucho mayor que la anchura.  
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Figura 2: Clasificación morfológica de las dolinas. Fuente: Peña, 2010. 

 

Además de la clasificación morfológica mostrada en la Figura 2, existe una clasificación 

genética de las dolinas, que atiende a los tipos de procesos que intervienen en su formación y al 

tipo de material del terreno (Gutiérrez, Guerrero y Lucha, 2008). En esta clasificación se 

diferencian cuatro tipos de procesos, que distinguen cuatro tipos de dolinas: 

- Dolinas de disolución (solution): Son formadas debido al ensanchamiento de diaclasas 

y planos de estratificación por disolución, cuando afloran rocas solubles a la 

superficie. La forma inicial de la depresión facilita la captura del drenaje superficial 

hacia la misma, acelerando su desarrollo. Estas dolinas provocan un hundimiento 

gradual y lento, y dan lugar a dolinas de artesa, cubeta o embudo. 

- Dolinas de flexión (sagging): Son semejantes a las dolinas de disolución, aunque en 

este caso, el ensanchamiento de planos de discontinuidad se produce por agua que 

circula como flujo freático a través del material que aflora en la superficie. La 

disolución que se da lugar entre el material aflorante y el sustrato soluble hace que el 

techo del último vaya rebajándose progresivamente. Esto provoca que el material 

aflorante se flexione gradualmente acomodándose al techo del sustrato soluble. La 

flexión del material aflorante impide el desarrollo de cavidades.  
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- Dolinas de colapso (collapse): Se producen cuando la disolución en el contacto entre 

el material aflorante y el sustrato soluble da lugar a cavidades subterráneas, que 

pueden alcanzar grandes dimensiones. Cuando la cavidad alcanza un tamaño crítico, 

el material situado por encima del techo de esta se desploma dando lugar a una 

dolina con paredes verticales. El hundimiento de este tipo de dolinas es brusco, y por 

lo tanto, muy peligroso. Por lo general, están asociadas a un colapso puntual en 

partes estructuralmente débiles (a favor de fallas o diaclasas) de una galería 

subterránea.  

- Dolinas de sufusión (suffosion): En este caso, la disolución se concentra a favor de 

diaclasas en el contacto entre la cobertera detrítica y el sustrato soluble, lo que da 

lugar a la formación de conductos de disolución. A través de estos conductos se 

produce la erosión y transporte de la cobertera detrítica. El proceso de hundimiento 

de estas dolinas en superficie suele ser gradual.  

Los tres tipos de materiales que se identifican en esta clasificación son: Cobertera 

detrítica (cover), sustrato insoluble (caprock)  y sustrato soluble (bedrock).  

De la combinación de los cuatro tipos de proceso y los tres tipos de materiales se pueden 

clasificar las dolinas en ocho formas simples. Estas formas simples se muestran en la Figura 3: 

 

 

Figura 3: Principales tipos de dolinas según proceso y material. Fuente: Gutiérrez et al., 2008. 

 

1.2 Antecedentes 

Rodríguez (1983) estudió las Sierras Exteriores en su Tesis Doctoral. En esta tesis habla 

sobre el modelado kárstico de la Sierra de Guara, en la que los materiales karstificables ocupan un 
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elevado porcentaje de la zona debido a su naturaleza principalmente caliza, aunque posee 

intercalaciones de rocas no solubles que sirven de separación a varias unidades hidrogeológicas. 

La variación de las zonas kársticas la representó mediante un mapa, el cual se muestra en la 

Figura 4: 

 

 

Figura 4: Zonas kársticas de las Sierras Exteriores. Fuente: Rodríguez, 1983. 

 

En este mapa se observa que las zonas kársticas sufren un ensanche progresivo desde el 

extremo occidental al oriental, ensanche que se produce debido a la orientación de pliegues 

dirección N-S, lo que hace que las calizas afloren en mayor extensión. Las potencias de estas 

calizas se ven también aumentadas progresivamente en dirección O-E, siendo la potencia en la 

Sierra de Guara entre 500 y 1.000 m. 

En su tesis, Rodríguez (1983) estudió también las dolinas de los Llanos de Cupierlo. En su 

estudio observaba que las dolinas eran medianas y pequeñas, desde los 2 a los 200 m. de 

diámetro, poco profundas y alargadas, según un eje mayor. Atendiendo a la clasificación 

morfológica de Cvijic (1983), son dolinas en cubeta. Atendiendo a la clasificación genética de Birot 

(1966) y Sweeting (1972) se corresponden a dolinas de disolución normal. La mayoría de ellas son 

de fondo plano, con bordes rara vez escarpados y límites poco precisos. En este estudio llegan a 

contabilizarse 248 dolinas en un área de 8,4 km2, obteniéndose una densidad de 29,5 dolinas/km2 

en la zona de Cupierlo. Mediante la orientación del eje mayor se aprecia una dirección de las 
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dolinas NNE-SSW, por lo que se observa un control estructural de las dolinas por macrofracturas 

de dirección NE-SW.   

Existen otros campos de dolinas en Aragón, los cuales están asentados sobre materiales 

carbonatados, aunque más recientes (pertenecientes al Plioceno), como los estudiados por Gracia 

(1987) en el sector central de la Cordillera Ibérica. Este estudio se basa en el análisis 

morfométrico de varios campos de dolinas. Entre estos campos, el que destaca sobre los demás 

es el campo de Villarroya P2, el cual posee 203 dolinas en un área de 5,79 km2, es decir, una 

densidad de 35,06 dolinas/km2. Otro de estos campos, el de la Tortuera, posee 365 dolinas en un 

área de 49,03 km2 (7,44 dolinas/km2). Además, también se estudian los campos de dolinas de 

Odón, El Villarejo y Villaroya P1, pertenecientes al mismo estudio de Gracia (1987), los cuales 

poseen una densidad de 6,52, 9,82 y 8,6 dolinas/km2 respectivamente. Los valores de elongación 

obtenidos varían entre 1,66 y 1,95. En este estudio se observa también una clara coincidencia 

entre las orientaciones de las dolinas y las del diaclasado.  

Chueca (1990) también estudió un campo de dolinas en la vertiente oriental del macizo 

Turbón (Huesca). Los análisis morfométricos realizados en este campo arrojan los siguientes 

resultados: área dolinizada de 0,482 km2 en un área total de 2,58 km2 (18,68% de área 

dolinizada). La densidad de las dolinas es de 35,65 dolinas/km2. El valor de elongación obtenido es 

de 1,41.  

 

2. Objetivos 

El objetivo general del proyecto es la caracterización de las dolinas de los Llanos de 

Cupierlo mediante el uso de fotografías aéreas y distintas herramientas SIG con el fin de 

determinar la morfometría y distribución espacial de las dolinas. Finalmente, los datos obtenidos 

permitirán determinar los factores condicionantes en su génesis.  

Los objetivos específicos se enumeran a continuación: 

- Elaborar un mapa final con la red de drenaje y la geología de la zona que permita 

determinar la importancia de la hidrología y la litología en la distribución espacial de las 

dolinas.  

- Realizar una cartografía de detalle del campo de dolinas de Cupierlo a una resolución de 

un metro. La digitalización de las dolinas se llevará a cabo mediante el uso de fotografías 

aéreas y modelos digitales del Terreno (MDT). 
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- Conocer la evolución temporal de la zona en los últimos años, gracias al estudio seriado 

de fotografías aéreas y MDT desde el 1956 hasta la actualidad. 

- Comparar la eficacia del uso de LIDAR de primera generación del CNIG frente a los MDT 

más antiguos, y de menor resolución. Los datos permitirán demostrar la importancia de la 

resolución en el estudio detallado de dolinas. 

 

3. Área de estudio 

La zona de estudio se sitúa en el Parque Natural de la Sierra y Cañones de Guara (Huesca), 

en las Sierras Exteriores aragonesas. Concretamente, al sur del antiguo municipio de Used y al 

norte de la localidad de Santa Cilia de Panzano. Está limitada al oeste por el río Guatizalema, y por 

el río Alcanadre al este. La zona de estudio abarca un área de 201 km2, si bien desde el punto de 

vista geológico, la gran parte de este estudio se centra en los Llanos de Cupierlo, lugar que ha 

sufrido un gran modelado kárstico en forma de un campo de dolinas. En la Figura 5 puede verse la 

zona de estudio con los Llanos de Cupierlo delimitados: 
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Figura 5: Mapa de localización de la zona de estudio. Fuente: Elab. propia. 
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Dentro de la zona de estudio se encuentran la localidad Nocito y los antiguos municipios 

de Bentué de Nocito y Used. Pueden observarse también picos importantes, como el Tozal de 

Guara (2077 m), el Tozal de Cubilas (1938 m) y Cabeza de Guara (1845 m). Estos picos crean un 

gran contraste con los valles de la zona, como el de Nocito o el Alcanadre, debido al gradiente de 

altura.  

Los Llanos de Cupierlo se encuentran a 1670 msnm y poseen un área de 8 km2. En este 

paraje, la principal vegetación que se encuentra es erizón (Echinospartum horridum) y boj (Buxus 

sempervirens), así como algún ejemplar de abeto (Abies alba). Se trata de una zona asociada 

tradicionalmente al pastoreo, por lo que se encuentran también zonas de pastos (ver Figura 6).  

 

Figura 6: Vista de los Llanos de Cupierlo y el Tozal de Cubilás. Fuente: Elab. propia. 

 

3.1 Clima 

Esta zona posee un clima característico, ya que se encuentra en la división geológica entre 

los Pirineos y la depresión del Ebro, aunque es un clima predominantemente continental. En la 

Figura 7 se muestran las temperaturas mensuales mínimas, máximas y medias en el periodo de 

1961-1990, tomadas en la Estación Meteorológica de Panzano (IAEST, 2020). 
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Figura 7: Temperaturas medias mensuales en el periodo 1961-1990. Fuente: Elab. propia a partir 

de IAEST, 2020. 

 

Como puede observarse, las temperaturas medias obtenidas en la zona rara vez alcanzan 

los 20°C, siendo julio y agosto los meses más cálidos, con máximas de 27°C y mínimas de 14°C 

aproximadamente. Enero, febrero, noviembre y diciembre son los meses más fríos, con 

temperaturas medias menores a los 5°C. Las temperaturas máximas de estos cuatro meses no 

alcanzan los 10°C, mientras que las mínimas de enero, febrero y diciembre se encuentran por 

debajo de los 0°C. 

Las precipitaciones son repetidas durante todo el año, aunque menos intensas en los 

meses de febrero, marzo y julio. Estas precipitaciones pueden ser observadas en la Figura 8, 

siendo estas una media en el periodo 1981-2010, tomadas en la misma estación.  
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Figura 8: Precipitaciones medias mensuales en el periodo 1981-2010. Fuente: 

Elab. propia a partir de IAEST, 2020. 

 

Los meses de primavera y otoño son los que más precipitaciones aportan, superándose 

los 80 mm de media mensual, mientras que los de verano e invierno rara vez superan esta 

cantidad.  

3.2 Geología 

En la zona de estudio se encuentran principalmente superficies estructurales en calizas 

(pertenecientes al Triásico superior, Cretácico superior y Paleoceno) de la formación Belsué-

Atarés, y superficies estructurales en areniscas y margas (pertenecientes al Luticiense) de las 

formaciones Pont de Suert, Adraén y Bona, y Tremp. (Rodríguez, 1986; Millán, 2006). La unidad 

más interesante, en la que se encuentran Los Llanos de Cupierlo, es caliza con depósitos fósiles de 

Nummulites y Alveolinas, con materiales pertenecientes al Luticiense, de la formación Guara 

(IGME, 1950; Rodríguez, 1986; Millán, 2006). En la Figura 9 se muestra una roca próxima a los 

Llanos de Cupierlo con depósitos fósiles: 
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Figura 9: Depósitos fósiles en rocas próximas a los Llanos de Cupierlo. Fuente: Elab. 

propia. 

 

Las principales estructuras que se encuentran en la zona de estudio son pliegues Norte-

Sur y Este-Oeste, así como fallas y cabalgamientos (IGME, 1950). 

Los principales anticlinales y sinclinales en dirección Norte-Sur son el sinclinal de Rodellar 

y los anticlinales de Balcés y Morrano, los cuales van acompañados de cabalgamientos de edades 

muy variables. Estas estructuras se caracterizan por ser vergentes al Oeste, por lo que este flanco 

se puede encontrar bastante verticalizado (entre 40° y 80°), mientras que el flanco Este rara vez 

supera los 30° de buzamiento. La edad de estas estructuras varía dentro del Eoceno. El anticlinal 

de Balcés se forma durante el Luticiense medio y queda fosilizado en el Luticiense superior. Sin 

embargo, el sinclinal de Rodellar y el anticlinal de Morrano se forman durante el Bartoniense, 

quedando fosilizados durante el Priaboniense (IGME, 1950).   

Por otro lado, el principal plegamiento en dirección Este-Oeste que se encuentra en la 

zona de estudio es el anticlinal de Cabeza de Guara. Este se caracteriza por poseer un plano axial 

casi vertical, con una ligera vergencia hacia el Sur (IGME, 1950). 

Las fallas, catalogadas como normales, son abundantes en la zona, las cuales poseen 

direcciones aproximadas de Nordeste-Suroeste (IGME, 1950).  

Todos estos factores generan una serie de superposiciones de estructuras con direcciones 

Norte-Sur y Este-Oeste, lo que se traduce en una zona estructuralmente compleja (IGME, 1950).  
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4. Metodología 

Inicialmente se ha delimitado la zona de estudio. Para ello se han tomado como límites el 

embalse de Vadiello al oeste y el río Alcanadre, a su paso por Rodellar, al este. Los municipios de 

Used y Santa Cilia limitan la zona al norte y sur respectivamente.  

Para llevar a cabo el presente TFG se ha seguido una secuencia de etapas concatenadas 

que se describen a continuación. Inicialmente, para conocer la problemática de la zona de estudio 

en detalle, se realizó una salida de campo a los Llanos de Cupierlo y su entorno. En ella se 

realizaron fotografías y se reconoció el terreno de una forma más precisa, prestando atención a la 

red de drenaje, morfometría de las dolinas y geología.  

El siguiente paso fue la búsqueda bibliográfica sobre los tipos de dolinas y sus procesos de 

formación en buscadores académicos como Alcorze, Dialnet y Researchgate, así como la 

búsqueda de estudios previos en la zona. Se han buscado también estudios sobre distintos 

campos de dolinas, con el fin de poder comparar el campo de los Llanos de Cupierlo con otros 

campos de dolinas existentes. Así mismo se procedió a la digitalización de la geología de la zona a 

partir de los mapas  geológicos de España a escala 1:50.000 (1ª serie) de las hojas 248 (Apiés) y 

249 (Alquezar) pertenecientes al Instituto Geológico y Minero de España (IGME). Las estructuras 

geológicas han sido digitalizadas a partir de los mapas del estudio de Millán (2006) “Estructura y 

cinemática del frente de cabalgamiento surpirenaico de las Sierras Exteriores aragonesas”. 

Posteriormente, se procedió a la cartografía, digitalización y caracterización morfométrica 

de dolinas en la toda la zona de estudio, con especial atención al campo de dolinas de los llanos 

de Cupierlo. Para ello fue necesario la descarga de las ortofotos del PNOA histórico (1956-57) y 

del PNOA Máxima Actualidad (2018) de las hojas MTN50 HU30 248 y 249. Estas descargas se han 

realizado desde el centro de descargas del Centro Nacional de Información Geográfica (CNIG). 

Utilizando la aplicación ArcMap de ArcGis, y habiendo elegido previamente el sistema de 

coordenadas (en este caso se ha escogido ETRS 1989 TM30N), se digitalizaron las dolinas por 

separado en el año 1956 y 2018, creando un mapa comparativo, para así conocer la evolución 

temporal de las dolinas.  

Con el fin de aplicar otras técnicas de teledetección, se procedió a digitalizarlas de nuevo 

partiendo de modelos digitales de elevaciones de diferente resolución. Se han utilizado un 

modelo digital del terreno con paso de malla de 5 m (MDT05), correspondientes al año 2010 y 

archivos LIDAR 1ª Cobertura en formato LAZ del Instituto Geográfico Nacional (IGN) del año 2010 

y una resolución de 0,5 m. Ambos archivos se han obtenido de la página web del centro de 
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descargas del CNIG. La digitalización de las dolinas se realizó sobre modelos de sombras 

obtenidos a partir de los datos del terreno. En el MDT de 5 m, este tuvo que ser transformado en 

modelo de sombras mediante la herramienta Hillshade de ArcMap (Spatial Analyst Tools > Surface 

> Hillshade).  

En el caso de los archivos LIDAR el proceso fue más complejo, siendo necesario su 

descompresión en formato LAS mediante el algoritmo laszip, el cual hay que descargarlo y 

añadirlo a la toolbox de ArcMap. Posteriormente se creó un LAS Dataset para trabajar todos los 

ficheros como si fueran uno solo (Data Management Tools > LAS Dataset > Create LAS Dataset). 

En las propiedades del Dataset, en el apartado Filter, se marcó la casilla ground para filtrar solo 

los datos de la superficie del terreno. El LAS Dataset obtenido se pasó a raster mediante la 

herramienta LAS Dataset to Raster (Conversion Tools > To Raster > LAS Dataset to Raster), 

asignando a la casilla de Sampling value un valor de 1. De este modo, la resolución del raster será 

de 1x1 m. Al raster obtenido se le aplica la Herramienta Hillshade (Spatial Analyst Tools > Surface 

> Hillshade). Sobre este Hillshade se realiza la digitalización de las dolinas. Si bien la resolución del 

LIDAR era originalmente de 0,5 m, el modelo de sombras tuvo que realizarse a una resolución de 

1 m dado que a una resolución de 0,5 m se obtenían numerosos artefactos. Se ha realizado un 

mapa comparativo de las digitalizaciones obtenidas mediante ambas metodologías. Estas dos 

digitalizaciones se utilizaron posteriormente para determinar la importancia de la resolución en la 

cartografía de dolinas.  

Una vez cartografiadas las dolinas, éstas fueron caracterizadas morfométricamente y 

espacialmente sobre el hillshade del MDE de 1 m de resolución (LIDAR). Para ello, se aplicaron 

distintas ecuaciones y herramientas en ArcMap. Los parámetros morfológicos obtenidos han sido:  

  Área, densidad y distribución espacial de las dolinas 

Se obtuvo el área máxima, mínima y media de las dolinas, así como el sumatorio de áreas, 

a partir de la herramienta Statistics. Para ello, primero se ha calculado el área de cada dolina 

mediante la herramienta Calculate geometry. Se han agrupado las dolinas en grupos dependiendo 

de su área (cada 1000 m2), para así obtener una mejor percepción de la variedad de las áreas 

obtenidas. La densidad de las dolinas se ha calculado a partir del cociente entre el número de 

dolinas y el área de la zona. El porcentaje de área dolinizada se ha obtenido mediante el cociente 

entre el sumatorio de áreas de las dolinas y el área de la zona, multiplicado por 100. La distancia 

euclídea mínima, máxima y media que existe entre dolinas se ha calculado utilizando la 

herramienta Calculate Distance Band from Neighbor Count (Spatial Statistics Tools > Utilities > 

Calculate Distance Band from Neighbor Count). Para conocer la dispersión de las dolinas se utiliza 
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la herramienta Average nearest neighbor (Spatial Statistics Tools > Analyzing Patterns > Average 

Nearest Neighbor). Esta herramienta utiliza el método de Clark y Evans (1954) para el cálculo del 

índice de distribución espacial, el cual consiste en una serie de ecuaciones que incluyen las 

siguientes variables: 

Distancia media al vecino más cercano (La): Se obtiene para cada dolina. Es la distancia 

entre el centroide de una dolina y el centroide de la dolina más próxima a ella. 

Distancia media teórica al vecino más cercano (Le): Es la distancia entre dolinas obtenida 

en un ámbito teórico, con una distribución de máxima aleatoriedad. Se obtiene mediante 

la siguiente ecuación, donde D es la densidad de dolinas:  

 

Índice de distribución espacial (R): Muestra el valor utilizado para definir la distribución de 

las dolinas. Se obtiene mediante la siguiente ecuación: 

 

 

El valor del índice varía entre 0 y 2,1491, siendo 0 el valor que representa una máxima 

agrupación y 2,1491 el que representa una máxima dispersión. Si el valor se encuentra próximo a 

1 significa que la dispersión es aleatoria.  

Pendiente 

El mapa de pendientes proporciona información acerca de la diferencia de altura entre las 

celdas del raster. En este caso se ha calculado en grados, mediante la herramienta Slope (Spatial 

Analyst Tools > Surface > Slope), en una escala de verde a rojo dependiendo si la pendiente es 

menor o mayor respectivamente.  

Red de drenaje 

Para poder obtener mapas de dirección y acumulación de flujo, así como de la red de 

drenaje, es necesario realizar una corrección al raster mediante la herramienta Fill (Spatial 

Analyst Tools > Hidrology > Fill). De este modo, no se tienen en cuenta posibles sumideros. El 

raster obtenido es el que se utiliza para la obtención de los tres mapas anteriormente 

mencionados. 
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El mapa de dirección de flujo representa la dirección de cada celda en base a la dirección 

de la mayor pendiente. A cada celda se le asigna un valor distinto dependiendo la dirección que 

tome, siendo 8 estos valores: 

Este: 1 

Sureste: 2 

Sur: 4 

Suroeste: 8 

Oeste: 16 

Noroeste: 32 

Norte: 64 

Nordeste: 128 

Para obtener este mapa se utiliza la herramienta Flow Direction (Spatial Analyst Tools > 

Hidrology > Flow Direction). A cada uno de los valores se le asigna un color.  

A partir del mapa de dirección de flujo se crea el mapa de acumulación de flujo, es decir, 

las áreas en las que se el flujo se concentra. La obtención de este mapa es mediante la 

herramienta Flow Accumulation (Spatial Analyst Tools > Hidrology > Flow Accumulation), y 

muestra, mediante valores de 1 o 0, las zonas en las que se acumula el flujo y las zonas en las que 

no, respectivamente.   

Utilizando la calculadora raster (Spatial Analyst Tools > Map Algebra > Raster Calculator) 

en el raster de acumulación de flujo, se obtiene la red de drenaje. Para ello hay que señalar que 

sólo debe mostrar los valores que estén por encima de 2000. Esta red de drenaje ha tenido que 

ser corregida, ya que los barrancos aparecían de forma descontinua.  

Longitud del eje mayor y orientación de las dolinas 

La obtención del eje mayor de cada dolina se ha generado mediante la herramienta 

Minimum Bounding Geometry (Data Management Tools > Features > Minimum Bounding 

Geometry). Esta herramienta convierte todos los polígonos en rectángulos, de modo que pueden 

conocerse tanto el eje mayor como el eje menor. A partir de estos dos valores se ha calculado el 

valor del factor de elongamiento, mediante el cociente entre el eje mayor y el menor. Este valor 

podría indicar el grado de control estructural que ejercen las fracturas y la pendiente de la zona 

sobre la forma de las dolinas. Si este valor es mayor que 1 quiere decir que la longitud de la dolina 
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es mayor que su anchura, por lo que la forma de esta podría verse afectada por algún factor 

externo. 

Por último, a partir de los datos de orientación de las dolinas, se ha generado un gráfico 

radial mediante la aplicación de Microsoft Excel, el cual muestra un sumatorio de las dolinas que 

se orientan a cada dirección. 

Los resultados obtenidos han sido comparados con otros estudios encontrados sobre 

campos de dolinas,  y sobre la zona de estudio. 

 

5. Resultados 

5.1 Evolución temporal entre 1956 y 2018 

Para conocer la evolución temporal de las dolinas entre los años 1956 y 2018 se realiza la 

comparación del número de dolinas, así como de sus áreas. Estos datos son obtenidos de las 

digitalizaciones en las ortofotos del PNOA histórico (PNOA 1956) y la de máxima actualidad (PNOA 

2018). 

 

Ortofotos PNOA 1956 PNOA 2018 Diferencia 

Número de dolinas 310 318 8 

Área máxima (m²) 5245,9926 9874,57378 4628,58118 

Área mínima (m²) 38,362532 84,060381 45,697849 

Sumatorio áreas (m²) 289257,311 311013,013 21755,702 

Media de áreas (m²) 933,088099 978,028342 44,940243 

Desviación estándar (m²) 900,279869 994,209556 93,929687 

Tabla 1: Comparación de la digitalización de las dolinas en los años 1956 

y 2018. Fuente: Elab. propia. 

 

Como puede observarse en la Tabla 1, se obtiene una mayor cantidad de dolinas en la 

digitalización de 2018, con áreas mínimas, máximas y medias más altas. La desviación estándar 

indica que el área de las dolinas es muy variada. La mayoría de las dolinas digitalizadas en ambos 

años son las mismas, aunque se identifican 10 dolinas nuevas en la digitalización de 2018, 
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teniendo estas un área entre 160 y 600 m2.  Igualmente, en 1956 se observan 13 dolinas que no 

se han digitalizado en 2018. Además, se han dado casos que en la digitalización sobre PNOA 2018 

se han identificado varias dolinas cuando en el de 1956 se ha identificado solo una. Esto ha 

sucedido en 5 dolinas digitalizadas en 1956, las cuales equivalen a 16 dolinas digitalizadas en 

2018. El mapa de evolución temporal de las dolinas puede observarse en el apartado de Anexos.  

 

5.2 Comparación de MDT05 y LAS 

En la Tabla 2 se expone la comparación entre las digitalizaciones de un MDE con 

resolución de 5 metros (MDT05) y otro con resolución de 1 metro (LIDAR). 

MDE Resolución 5 metros Resolución 1 metro Diferencia 

Número de dolinas 232 274 42 

Área mínima (m²) 255,2981 27,673701 227,62 

Área máxima (m²) 38545,94403 16648,77882 21897,16 

Sumatorio áreas (m²) 747655,0174 714644,7971 33010,22 

Media de áreas (m²) 3222,650937 2608,19269 614,45 

Desviación estándar (m²) 4097,775768 3018,827052 1078,94 

Tabla 2: Comparación de la digitalización de las dolinas en resoluciones de 5 y 1 metro. 

Fuente: Elab. propia. 

 

Atendiendo al número de dolinas, se observa que en la digitalización de 1 metro de 

resolución existe un mayor número. En la digitalización con resolución de 1 m se observan 22 

dolinas nuevas, las cuales varían de 45 a 1750 m2. Además, se observa una dolina en la 

digitalización de 5 m que no se observa en la de 1 m. El resto de dolinas de diferencia se tratan de 

dolinas que en la digitalización con la resolución de 5 m se han digitalizado como una sola, 

mientras que en la de 1 m se han diferenciado varias. Esto ha sucedido en 6 dolinas digitalizadas 

sobre el MDE de 5 m, siendo 27 las dolinas identificadas sobre el MDE de 1 m.  

Por otro lado, atendiendo al área máxima, mínima, media, y al sumatorio de áreas, se 

observan valores mayores en la resolución de 5 metros que en la de 1 metro. Igual que en el 

anterior caso, la desviación estándar indica una gran dispersión en los datos del área de las 
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dolinas. El mapa de comparación entre MDE de 1 m y 5 m puede observarse en el apartado de 

Anexos. 

5.3 Caracterización de las dolinas 

Para la caracterización de las dolinas, se ha optado por usar la cartografía de dolinas de 

mayor resolución, obtenida mediante el MDE de 1 m. Los datos obtenidos se exponen en los 

siguientes apartados: 

5.3.1 Área, densidad y distribución espacial de las dolinas  

Como ya se ha expuesto anteriormente, el número de dolinas obtenido mediante la 

metodología usada es de 274. La zona de estudio tiene un área de 201,1 km2, por lo que la 

densidad de dolinas en la zona de estudio es de 1,36 dolinas/km2. Sin embargo, si sólo se tiene en 

cuenta el área de los Llanos de Cupierlo (8,07 km2), donde se concentran 256 dolinas de las 274 

(es decir, el 93% de las dolinas), se obtiene una densidad de 31,72 dolinas/km2.  

En cuanto al porcentaje de dolinización de la zona de estudio (201,1 km2), se ha obtenido 

un valor de 0,35 % de área dolinizada. Sin embargo, teniendo en cuenta el área de los Llanos de 

Cupierlo (8,07 km2), se obtiene un valor de 8,85 % de área dolinizada. 

Atendiendo al área de las dolinas, se han obtenido unos valores muy variados, con un 

área mínima de 27,67 m2 y máxima de 16648,78 m2. Mediante la ¡Error! No se encuentra el 

origen de la referencia. se muestra el área máxima, mínima y media de las dolinas digitalizadas. 

Además, en la Tabla final con área, longitud de eje mayor y orientación de las dolinas 

digitalizadas, que se encuentra en el apartado de Anexos, se puede observar el área de todas las 

dolinas digitalizadas.  

 

Área mínima (m²) 27,673701 

Área máxima (m²) 16648,77882 

Sumatorio áreas (m²) 714644,7971 

Media de áreas (m²) 2608,19269 

Tabla 3: Área mínima, máxima y media de 

las dolinas, con sumatorio de áreas. Fuente: 

Elab. propia. 
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Para poder ver mejor la variedad en estas áreas se ha creado el siguiente gráfico de barras 

(Figura 10: Número de dolinas dependiendo de su área, agrupadas cada 1000 m2. Fuente: Elab. 

propia.Figura 10), el cual muestra el número de dolinas dependiendo del área, en grupos 

divididos cada 1000 m2.  

 
 

  

 

 

 

Como puede observarse, 107 de las dolinas son menores de 1000 m2, y 264 son menores 

de 10000 m2. Además se identifican 10 dolinas mayores de 10000 m2, las cuales, analizando su 

morfología, es posible que sean producto de una unión de dos o más dolinas, es decir, uvalas (ver 

Figura 11).   

Figura 10: Número de dolinas dependiendo de su área, agrupadas cada 1000 m2. 

Fuente: Elab. propia. 
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Figura 11: Posible uvala en los Llanos de Cupierlo. Fuente: Elab. propia. 

En los cálculos realizados para las distancias al vecino más cercano, la cual es la distancia 

entre dolinas, se han obtenido unos valores de distancia mínima y máxima de 11,05 y 364,74 m 

respectivamente. La distancia media es de 82,61 m, como puede observarse en la Tabla 4: 

 

Distancias al vecino más cercano (en m) 

Distancia mínima  11,0483 

Distancia máxima  364,7369 

Distancia media  82,6098 

Tabla 4: Distancias entre dolinas. Fuente: 

Elab. propia. 

 

El índice al vecino más cercano, o índice de distribución espacial, así como la distancia 

media observada y esperada, tanto de la zona de estudio como de los Llanos de Cupierlo, se 

exponen en la Tabla 5 y Tabla 6: 
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Zona de estudio 

Distancia media observada (m) 82,6098 

Distancia media esperada (m) 428,2454 

Índice de distribución espacial 0,192903 

Tabla 5: Índice de distribución espacial de 

las dolinas de la zona de estudio. Fuente: 

Elab. propia. 

 

El índice de distribución espacial de la zona de estudio indica que la distribución de las 

dolinas tiende al agrupamiento de estas, ya que el área que se ha utilizado para este cálculo (el 

área de toda la zona de estudio) es de 201,1 km2.  

 

Llanos de Cupierlo 

Distancia media observada (m) 82,6098 

Distancia media esperada (m) 85,8 

Índice de distribución espacial 0,962721 

Tabla 6: Índice de distribución espacial de 

las dolinas de la zona de estudio. Fuente: 

Elab. propia. 

 

El índice de distribución espacial de los Llanos de Cupierlo indica que la distribución de las 

dolinas tiende a una dispersión aleatoria de estas. El área utilizada para el cálculo, en este caso, es 

de 8,07 km2. 

Como se puede observar, los índices de distribución varían mucho dependiendo si se 

tiene en cuenta la zona de estudio en su totalidad o únicamente los Llanos de Cupierlo. Esto se 

debe principalmente a la diferencia de áreas en los cálculos y a la escasez de dolinas fuera de los 

Llanos de Cupierlo.  
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5.3.2 Geología 

El Mapa final de las dolinas de la zona de estudio y el Mapa en detalle de los Llanos de 

Cupierlo (ver Anexo) muestra que las 274 dolinas digitalizadas se asientan sobre la unidad 

geológica de calizas con nummulites y alveolinas lo que significa que la litología juega un papel 

esencial en el desarrollo de las dolinas. A pesar de existir otras unidades con litologías 

carbonatadas (ej: calizas tableadas; ver Mapa final de las dolinas de la zona de estudio, en 

Anexos), estás no muestran el desarrollo de dolinas. Las fallas presentes en la zona, las cuales son 

abundantes, poseen una dirección predominante NE-SO. En el Mapa final de las dolinas de la zona 

de estudio y en el Mapa en detalle de los Llanos de Cupierlo (ver Anexo), se muestran las fallas 

presentes los Llanos de Cupierlo y la zona de estudio. 

5.3.3 Pendiente 

La pendiente obtenida en la zona de estudio se muestra mediante el Mapa de pendientes 

de los Llanos de Cupierlo, el cual se encuentra en el apartado de Anexos. Este mapa muestra que 

la mayor parte de la zona se encuentra asentada sobre una pendiente escasa, con valores entre 

los 0 y los 8,4°, aunque aparecen pequeñas zonas con pendientes mayores, que por lo general 

coinciden con las dolinas. 

5.3.4 Red de drenaje 

Se observa continuidad en la red de drenaje de la zona de estudio, a excepción de los 

Llanos de Cupierlo, donde la red de drenaje se encuentra completamente distorsionada como 

consecuencia de los fenómenos kársticos. Es evidente que estas dolinas representan las vías de 

entrada de las aguas superficiales dentro del sistema kárstico de la Sierra de Guara. La red de 

drenaje obtenida se muestra mediante el Mapa final de las dolinas de la zona de estudio y el 

Mapa en detalle de los Llanos de Cupierlo, los cuales se encuentran en el apartado de Anexos. 

5.3.5 Longitud del eje mayor y orientación de las dolinas 

En la Tabla final con área, longitud de eje mayor y orientación de las dolinas digitalizadas, 

encontrada en el apartado de Anexos, se pueden observar las longitudes del eje mayor y la 

orientación de las 274 dolinas. 

Las longitudes del eje mayor de las dolinas varían entre 6,87 y 330,38 metros. La longitud 

media del eje mayor es de 69,59 metros, mientras que la del eje menor es de 39,52. El valor de 

elongación obtenido mediante el cociente entre el eje mayor y el eje menor es de 1,76, por lo que 

se entiende que la morfología de las dolinas está siendo influenciada por algún factor externo, 

como la pendiente o la orientación de fracturas (un valor de 1 equivaldría a una dolina circular). 
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Mediante la Figura 12, en forma de gráfico radial, se muestra el sumatorio de las 

orientaciones de las dolinas, divididas en franjas de 10 grados. Como puede observarse, la 

dirección predominante que toman estas dolinas es NE-SO. 

 

 
 

6. Discusión  

 

 

6. Discusión 

6.1 Caracterización temporal y espacial de las dolinas. 

Observando las cartografías de dolinas realizadas a partir de las fotografías aéreas, se 

observa que el  número y área de las dolinas es mayor en la digitalización de 2018 que en la de 

1956. Concretamente se observa un incremento de 8 dolinas nuevas entre 1956 y 2018 y un 

aumento del sumatorio del área de las mismas de 21755 m2. La diferencia creciente en el número 

y área de las dolinas apunta a la aparición de nuevas dolinas y a un crecimiento de las existentes 

en los últimos 72 años.  

Figura 12: Rosa de direcciones con sumatorio de orientaciones del eje mayor de las dolinas. Fuente: 

Elab. propia. 
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Cabe también la posibilidad de que todas las dolinas estuvieran presentes ya en el 1956, 

pero debido a la resolución de la imagen no se cartografiaran todas las existentes. De ser cierta 

esta posibilidad, las dolinas no habrían experimentado ningún crecimiento ni se hubieran 

formado nuevas dolinas.  

Para poder salir de dudas sobre la influencia de la resolución en la identificación de 

dolinas en el área de estudio, se han comparado los resultados obtenidos a partir de los MDT de 5 

m y LIDAR a 1 m. En este caso, calculando la diferencia entre las digitalizaciones con ambas 

resoluciones, mostrada en la Tabla 2, se observa que la digitalización a 1 m de resolución permitió 

cartografiar 42 dolinas más que las observadas con el MDT de 5 m. Evidentemente, debido a la 

lentitud de los procesos kársticos en calizas y la inexistente diferencia temporal entre la 

adquisición de los dos modelos de elevaciones, la diferencia en el número de dolinas es debido a 

la mejoría en la resolución espacial que aporta el LIDAR. Este incremento debido al aumento en la 

resolución aportada por los datos LIDAR permite visualizar dolinas pequeñas que no se verían con 

un tamaño de pixel mayor y diferenciar varias dolinas juntas entre sí que eran cartografiadas 

como una sola  con el MDT de 5 m de resolución. 

Del mismo modo, existen diferencias notables en el área de las dolinas dependiendo de la 

resolución de modelo digital de elevaciones utilizado. Las dolinas digitalizadas con el MDT de 5 m 

de resolución tienen una mayor área media, mínima y máxima. Con este método, el sumatorio de 

las áreas de todas las dolinas es de 747655 m2. Por el contrario, considerando los datos LIDAR a 

una resolución de 1 m  el sumatorio de las áreas es de 714645 m2, menos que el obtenido a una 

resolución de 5 m. Esta diferencia es debido al mayor tamaño del píxel en los modelos de 5 m, 

que hace que se sobreestime el tamaño de las dolinas digitalizadas  

En consecuencia, los mejores resultados se obtienen utilizando tanto fotografías aéreas 

como modelos de elevaciones de alta resolución. En este caso tanto las ortofotos del PNOA de 

Máxima Actualidad como los datos LIDAR a una resolución de 1 m fueron herramientas esenciales 

para llevar a cabo una cartografía de detalle. No obstante, se identificó un mayor número de 

dolinas utilizando la ortofoto del PNOA. Concretamente, se detectaron 44 dolinas más con la 

ortofoto que con el LIDAR. Esto puede deberse a que algunas dolinas tengan una profundidad 

inferior a 1 m y en consecuencia queden fuera del alcance de detección del LIDAR (resolución de 1 

m). Sin embargo, la salida de campo demuestra que todas las dolinas incluidas las de menor 

tamaño presentan una profundidad muy superior al metro. Esto sugiere que la falta de visión 

tridimensional de las ortofotos, a pesar de su alta resolución, puede llevar a errores y una 

sobreestimación del número y área de las dolinas, y de la densidad de dolinización. Atendiendo a 

estos datos, la metodología que ha resultado ser más eficaz para la cartografía de dolinas ha sido 
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la elaboración de mapas de sombreado con datos LIDAR. En cualquier caso, siempre es 

recomendable comprobar la cartografía en el campo en caso de que hubiera dolinas de pequeño 

tamaño, de geometrías en artesa colmatadas de sedimentos o con profundidades inferiores al 

metro que escapen a la resolución de los datos LIDAR. 

6.2 Morfometría de las dolinas 

Como puede observarse en los resultados, la diferencia entre el área mínima y máxima de 

las dolinas de los Llanos de Cupierlo es notoria. Es probable que algunas de las dolinas que mayor 

superficie abarcan sean producto de la unión de dos o más depresiones, lo que se conoce como 

uvalas. Es también destacable que la mayoría de las dolinas de mayor área se sitúan en zonas de 

fondo de barranco, lo que podría favorecer el aumento de su tamaño. 

La densidad de dolinas obtenida en este estudio se ha comparado con los campos de 

dolinas estudiados por Gracia (1987) en el sector central de la Cordillera Ibérica y por Chueca 

(1990) en el sector oriental del Pirineo, obteniéndose la Tabla 7: 

 

Campo de dolinas Área (km²) N. Dolinas Densidad (dolinas/km²) Área dolinizada (%) 

Llanos de Cupierlo 8,07 256 31,72 8,85 

Villaroya P2 5,89 203 35,06 5,42 

Villaroya P1 3 26 8,6 1,64 

La Tortuera 49,03 365 7,44 8,1 

Odón 18,1 118 6,52 7,37 

El Villarejo 16,4 161 9,82 2,97 

Turbón 2,58 92 35,65 18,68 

Tabla 7: Área, número de dolinas, densidad y área dolinizada de los campos de dolinas. Fuente: 

Elab. propia con datos propios y de Gracia, J. (1987) y Chueca, J. (1990). 

 

Como se observa en la Tabla 7, la densidad de dolinas en los llanos de Cupierlo es entre 3 

y 4 veces mayor que Villaroya P1, La Tortuera, Odón y El Villarejo y semejante a la obtenida en 

Villaroya P2 y en el Turbón. Además, la densidad de dolinas obtenida en este estudio para los 

Llanos de Cupierlo (31,72 dolinas/km2) es ligeramente superior al calculado por Rodríguez Vidal 

en 1983, el cual mostraba una densidad de 29,5 dolinas/km2. Esta ligera diferencia se debe a que 
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el número de dolinas identificadas mediante la metodología utilizada en el presente estudio es 

mayor. Cabe destacar que el trabajo de Rodríguez Vidal (1983), a pesar de ser un trabajo antiguo 

y no disponer de modelos digitales de elevaciones, consiguió unos resultados muy próximos a la 

realidad, gracias a un exhaustivo trabajo de fotogrametría y trabajo de campo. 

Igualmente, si se compara el porcentaje de área dolinizada en Cupierlo con respecto a 

otros campos de dolinas del territorio aragonés, se observa que los Llanos junto con el campo de 

dolinas del Turbón ofrecen la mayor área dolinizada de todas las zonas estudiadas. Esto significa, 

que no solo existe un gran número de dolinas sino que además existen dolinas de grandes 

dimensiones ocupando una importante área de la zona de estudio. Finalmente, atendiendo al 

índice de distribución espacial y a que no existen valores de distribución para el campo de dolinas 

del Turbón, el campo de dolinas de Cupierlo es el que tiene un índice más cercano al 

agrupamiento (Tabla 8). Esto quiere decir que las dolinas de Cupierlo poseen menor distancia 

entre ellas que en el resto de campos  y por tanto, representa la zona con el mayor agrupamiento 

de dolinas por km2. 

 

 

Campo de dolinas Índice de distribución espacial 

Llanos de Cupierlo 0,962721 

Villaroya P2 2,146 

Villaroya P1 1,9 

La Tortuera 1,16 

Odón 1,86 

El Villarejo 1,55 

Tabla 8: Índice de distribución espacial de los campos de 

dolinas. Fuente: Elab. propia con datos propios y de 

Gracia (1987). 

 

Como se ha visto en el apartado de resultados, las longitudes del eje mayor de las dolinas 

varían entre los 6,87 y 330,38 metros, valores que difieren respecto al estudio realizado por Vidal 

(1983) en los Llanos de Cupierlo. Esta diferencia podría corresponderse a variaciones en la 

metodología utilizada para delimitar las dolinas.  
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A modo de comparación se ha realizado la Tabla 9, con los valores medios de elongación 

tanto de los Llanos de Cupierlo como de los estudios de campos de dolinas en zonas carbonatadas 

estudiados por Gracia (1987) y Chueca (1990). 

 

Campo de dolinas Elongación 

Llanos de Cupierlo 1,76 

Villaroya P2 1,69 

Villaroya P1 1,66 

La Tortuera 1,95 

Odón 1,72 

El Villarejo 1,82 

Turbón 1,41 

Tabla 9: Valor medio de elongación 

de las dolinas en los campos de 

dolinas. Fuente: Elab. propia con 

datos propios y de Gracia (1987) y 

Chueca (1990). 

 

En el estudio de Gracia (1987) se habla sobre que este factor de elongación aporta 

información sobre el control estructural de factores como el diaclasado, concluyendo que estos 

campos están claramente influidos por estos factores. El valor de elongación obtenido para los 

Llanos de Cupierlo indica que existe un claro control estructural de las dolinas por parte de las 

diaclasas presentes en la zona. Además, analizando la orientación de las dolinas, la cual es 

predominantemente SO-NE, se observa una posible relación con las fallas de la zona, las cuales 

poseen la misma dirección. 

En lo que respecta a la pendiente, el bajo valor de este parámetro en la zona de los Llanos 

de Cupierlo hace de esta un lugar idóneo para la captación de agua, tanto de las precipitaciones 

en forma de lluvia como del posible deshielo. Las zonas que aparecen con pendientes mayores 

corresponden a dolinas que poseen algún lateral escarpado (por lo general, dolinas de mayor 

tamaño). 
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Por lo general, la red de drenaje obtenida en la zona de estudio presenta una morfología 

bien jerarquizada. Los principales receptores de esta red son el río Guatizalema, en la zona más 

occidental, y el río Alcanadre en la zona oriental. La excepción a esta jerarquización aparece en la 

zona de los Llanos de Cupierlo, lugar en el que la red de drenaje desaparece o queda difusa. Esto 

indicaría que los Llanos de Cupierlo se trata de una zona de recarga de acuíferos, algo que se 

potenciaría con la escasa pendiente del lugar. 

6.3 Origen de las dolinas 

En la zona de estudio, a pesar de existir más formaciones carbonatadas, solo aparecen 

dolinas asociadas a la formación Guara (calizas con nummulites y alveolinas). Es por ello que esta 

unidad geológica debe contener una serie de características geológicas que la hacen propensa a 

experimentar los procesos kársticos. A falta de estudios petrográficos que den luz a esta cuestión, 

es posible que sean calizas con una mayor porosidad intergranular que favorezca la infiltración, 

circulación de las aguas y, en consecuencia, su disolución.  

Si bien la karstificación es mucho más intensa en esta unidad carbonatada, no se 

encuentran estos fenómenos de disolución en toda su extensión. De hecho, las dolinas aparecen 

en dos zonas claramente diferenciables: Los Llanos de Cupierlo (256 dolinas), y su vertiente norte 

(18 dolinas). Es muy probable que estas 18 depresiones se hayan producido por la naturaleza 

caliza de la zona y por la escasa pendiente.  En el caso de los Llanos de Cupierlo entran en juego, 

además de estos dos factores, otros como la fuerte fragmentación que ha sufrido la zona, la red 

de drenaje, que favorece la captación de agua en la zona de los Llanos, o el clima lluvioso y frio de 

la zona, que favorece la disolución de las calizas. Ligado a esto último, se encuentra otro factor 

importante en el proceso de dolinización de los Llanos, el cual es la altura, que hace que el clima 

de la zona sea propicio para crear estas formaciones. Las dolinas identificadas se tratan de dolinas 

en cubeta, las cuales se han generado por la disolución del sustrato soluble.  

 

 

7. Conclusiones 

Respecto a la evolución temporal de las dolinas, se podría afirmar que las dolinas han 

crecido en área y en número. Sin embargo, se cree que para un buen estudio de estas 

características es conveniente usar otro tipo de metodología, ya que con las ortofotos utilizadas 

no se trabaja con la precisión necesaria para este tipo de estudios. 

Respecto a la comparación entre MDT05 y LIDAR se obtiene un mejor resultado en la 

digitalización de las dolinas con MDE de 1 metro de resolución (LIDAR) que con los de 5 metros 
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(MDT05). Si bien es cierto que trabajar con este tipo de archivos requiere de ordenadores más 

potentes, y en algunos procesos de ArcMap el tiempo invertido es mayor. 

Respecto al origen de este campo de dolinas se puede concluir que se debe 

principalmente los siguientes factores: al clima frío y lluvioso de la zona, ligado a la altura, a su 

naturaleza caliza y a la escasez de pendiente, lo que provoca una recepción del recurso hídrico en 

los Llanos. 

Comparando con otros estudios, la densidad de dolinas y el porcentaje de área dolinizada 

de los Llanos de Cupierlo son bastante altos, obteniéndose una densidad de 31,72 dolinas/km2 y 

un porcentaje de dolinización de 8,85 %.  

Las dolinas de los Llanos de Cupierlo poseen un índice de dispersión más cercano al 

agrupamiento que en otros estudios, indicando que estas dolinas se encuentran concentradas, a 

poca distancia unas de otras.  

El valor de elongación y la orientación de las dolinas indican un control estructural de 

estas por parte de las fallas presentes en la zona, observándose una dirección de las dolinas NE-

SO, tal como afirmó Rodríguez (1983). 
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Tabla final con área, longitud de eje mayor y orientación de las dolinas digitalizadas 

 

Dolina Area (en m²) Longitud de eje mayor (en m) Orientación (en °) 

1 579,008214 27,880362 4,085617 

2 61,044029 9,755163 78,690068 

3 62,72414 10,583354 90 

4 114,24754 16,171095 75,963757 

5 50,403327 10,327315 98,130102 

6 67,764472 12,179249 80,537678 

7 57,648805 11,052392 101,309932 

8 38,082513 10,583354 36,869898 

9 264,897483 24,795201 102,528808 

10 27,673701 6,875314 101,309932 

11 70,564657 10,439357 9,462322 

12 56,703742 11,441697 54,462322 

13 197,518036 18,256287 90 

14 183,02708 18,864669 23,198591 

15 260,522194 26,382254 6,009006 

16 178,931809 20,933792 74,054604 

17 86,630718 12,211379 164,054604 

18 217,049325 19,557045 87,273689 

19 12203,90546 234,329388 52,744711 

20 2662,555728 60,838832 74,054604 

21 1646,928697 63,961029 62,102729 

22 1014,366948 56,086287 26,565051 

23 716,987321 34,92507 90 

24 4732,872369 131,336508 45 

25 406,026798 26,463474 168,690068 

26 287,018943 24,508665 98,130102 

27 270,392846 31,947885 26,565051 

28 2129,890573 79,157114 48,012788 

29 1136,314997 84,03004 17,525568 

30 580,75833 31,413031 175,601295 

31 3776,889274 152,34178 33,690068 
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32 505,15334 24,287802 86,185925 

33 433,468609 44,153014 45 

34 535,395336 31,580631 81,869898 

35 374,664728 30,494205 72,645975 

36 162,970756 17,926647 113,19859 

37 258,17704 18,93208 116,565051 

38 1672,830407 61,957091 81,253838 

39 342,191335 23,048787 87,510447 

40 394,406031 25,262998 86,633539 

41 151,166227 19,625015 30,963757 

42 2931,662239 60,854288 0 

43 1102,135241 41,42436 51,340192 

44 956,21936 36,465833 141,340192 

45 1489,129532 49,719539 3,900494 

46 1211,954989 42,333418 0 

47 1361,589865 52,607523 41,987212 

48 235,390536 20,108374 53,130102 

49 14626,59035 209,112973 6,46982 

50 3528,232863 114,6819 60,068488 

51 11253,24271 230,510856 41,378515 

52 833,930039 33,022062 56,309932 

53 8195,790921 158,179581 50,411869 

54 1857,747611 77,598718 21,037511 

55 5996,770786 212,825239 29,859016 

56 975,689395 71,479399 50,194429 

57 5812,1336 205,765998 35,537678 

58 11880,65912 292,513758 22,520566 

59 3733,311398 96,639575 32,275644 

60 2804,315084 93,003843 26,565051 

61 4681,208959 152,085436 36,634114 

62 691,785658 50,38173 17,354025 

63 576,881824 40,809686 29,475889 

64 4620,961233 141,012348 15,945396 

65 477,781534 27,484731 97,125016 
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66 1900,065404 57,679282 90 

67 1326,307536 49,154996 104,036243 

68 693,18575 33,744619 112,619865 

69 1906,225811 51,329269 0 

70 3125,00625 73,981576 81,573031 

71 579,778265 28,932674 82,234834 

72 574,737933 28,722966 93,814075 

73 585,938672 28,782055 71,565051 

74 1861,002826 51,130389 85,763605 

75 326,396542 25,306859 121,607502 

76 4180,115887 83,111832 79,695154 

77 13984,68299 226,78647 50,355825 

78 372,984617 29,922388 16,38954 

79 7614,26254 115,485688 63,434949 

80 810,373485 39,39795 102,094757 

81 3237,013642 72,156589 51,632515 

82 692,170683 32,438067 70,016893 

83 4674,777285 91,067138 87,397438 

84 674,450764 33,141528 120,068583 

85 534,222759 29,934247 45 

86 7218,35141 99,001902 91,363928 

87 5318,819792 89,802741 81,869898 

88 1159,232759 43,656337 90 

89 2577,045085 58,254734 77,005383 

90 2613,79751 66,502136 67,380135 

91 3266,809359 70,890895 88,492564 

92 3621,864043 70,995725 68,19859 

93 990,784142 39,893665 113,962489 

94 8913,994572 156,82635 40,322582 

95 529,794966 27,475359 74,744881 

96 4292,12328 86,011951 55,407711 

97 1813,399684 51,100241 47,489553 

98 3102,604772 84,033855 75,256437 

99 6693,001737 129,465668 44,341457 
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100 6709,802846 112,516564 56,976132 

101 5888,788659 92,353508 43,66778 

102 5818,224002 93,36088 108,970408 

103 2852,828286 67,264014 106,927513 

104 3335,020111 75,416229 98,426969 

105 3477,269499 74,833225 84,805571 

106 1893,48497 52,493438 126,869898 

107 2040,214654 52,826867 83,659808 

108 3317,658965 66,712826 102,994617 

109 4549,740282 88,372643 94,085617 

110 1095,992335 44,124183 95,710593 

111 1807,239278 53,913344 94,085617 

112 4252,920692 84,721058 116,565051 

113 1064,630265 38,100076 0 

114 1298,725716 47,677917 57,994617 

115 3101,624707 63,239664 96,519802 

116 2575,469981 69,628849 7,853313 

117 4571,266703 85,32741 76,429566 

118 2775,648192 72,771434 56,821488 

119 548,451198 32,366137 93,814075 

120 877,017883 35,845479 68,962489 

121 3604,782915 84,396488 36,469234 

122 544,670948 33,200464 42,70939 

123 235,950573 19,64435 45 

124 987,27516 48,131364 13,570434 

125 1808,219342 49,980691 169,695154 

126 678,239764 35,754796 99,462322 

127 581,21336 29,287138 23,198591 

128 8615,503622 116,319579 78,366366 

129 2559,543929 64,375906 83,088773 

130 4842,359595 85,22984 70,463345 

131 5271,676055 89,746062 77,735226 

132 800,704096 34,727667 76,328693 

133 1030,196743 41,282702 37,03039 
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134 1374,514468 59,501257 55,491477 

135 1359,629735 50,999005 68,198591 

136 2328,94871 79,376151 59,198554 

137 429,058318 30,6071 60,945396 

138 745,969234 40,813061 177,273689 

139 455,520064 28,522612 32,005383 

140 1514,934986 67,780723 40,914383 

141 1577,309102 49,486638 42,70939 

142 7923,717964 152,012238 33,951094 

143 8648,895826 180,62041 34,64668 

144 1653,544134 48,405992 75,465545 

145 9789,901132 190,922481 40,192046 

146 3274,956147 75,44656 56,888658 

147 579,148224 37,07542 177,306887 

148 5683,255094 109,842281 28,810794 

149 7248,250384 119,470466 78,023868 

150 1726,033918 58,587316 162,474432 

151 1698,03207 52,522518 172,405357 

152 1716,51329 54,687903 62,354025 

153 3585,356633 76,582755 17,354025 

154 874,777735 41,394863 86,185925 

155 2596,331358 75,576481 39,957549 

156 1469,536989 46,405907 4,763642 

157 2197,025003 65,623882 115,201124 

158 958,78328 38,914521 45 

159 3197,251018 95,034368 43,22853 

160 8250,464529 175,983793 52,224316 

161 4757,513995 94,6604 26,565051 

162 3095,884328 83,366738 56,768289 

163 965,503723 39,077001 67,380135 

164 2354,39539 85,577481 52,206057 

165 3976,262433 80,388329 94,573921 

166 6400,662443 176,952751 36,501441 

167 296,81959 22,718496 26,565051 
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168 201,053269 21,92215 60,255119 

169 1825,16046 78,272404 20,854458 

170 2904,911724 117,396499 23,498566 

171 769,490786 35,140881 71,565051 

172 639,002174 30,53849 105,255119 

173 1368,730336 56,144033 49,085617 

174 467,070827 31,044769 5,194429 

175 285,618851 21,13412 146,309932 

176 5493,962601 162,046497 44,045159 

177 1196,238952 90,982219 34,215702 

178 5161,300645 155,327353 36,253838 

179 13791,47024 265,489936 17,020526 

180 3761,348249 121,597869 57,652557 

181 1526,100723 82,503068 16,587339 

182 11866,06316 273,757459 8,775056 

183 16648,77882 330,385431 28,379243 

184 863,016959 34,138979 104,036243 

185 3319,339076 114,331747 16,837473 

186 2316,872913 107,346545 29,357754 

187 1317,057642 46,491784 142,80009 

188 946,462466 48,193208 71,565051 

189 662,523726 32,875297 56,309932 

190 1057,349785 45,823736 69,145542 

191 2598,011468 115,166225 48,012788 

192 3560,715007 88,780726 31,218403 

193 9703,760447 171,501219 50,630683 

194 2959,235309 61,842003 92,29061 

195 425,628091 27,760564 10,619655 

196 836,135185 37,785604 120,256437 

197 3584,796596 92,676872 29,744881 

198 1751,235581 47,179757 49,398705 

199 8552,884489 121,079299 171,326826 

200 1932,687557 57,657484 72,897271 

201 1552,42246 52,014081 29,054604 
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202 1326,149165 53,714798 8,130102 

203 2186,384301 59,266785 0 

204 12724,03978 156,68174 67,750976 

205 6813,409684 104,408113 25,016893 

206 3774,089089 75,686267 105,524111 

207 5065,534325 87,272577 14,036243 

208 2087,817796 56,777001 39,805571 

209 849,576072 43,443879 65,556045 

210 9336,936237 177,239751 22,217594 

211 588,598848 30,76463 26,565051 

212 6010,876717 131,392167 29,475889 

213 2212,706038 70,01143 64,093492 

214 2302,311952 56,513254 85,236358 

215 1806,679241 50,391981 32,275644 

216 1449,375659 51,517191 68,962489 

217 483,871935 24,641669 165,963757 

218 1897,965265 51,851791 60,255119 

219 6278,574385 116,466919 71,565051 

220 3853,614338 124,148074 30,963757 

221 1352,489264 47,845299 56,309932 

222 3147,407729 103,046707 51,709837 

223 1051,189378 42,776919 4,398705 

224 929,661358 45,014739 28,300756 

225 9980,418706 179,876932 79,508523 

226 2299,966798 56,598833 104,036243 

227 1782,072617 52,588259 99,462322 

228 5887,73859 148,746312 21,077494 

229 1147,935764 40,693002 42,70939 

230 4191,351629 90,833689 80,073754 

231 328,146658 33,338662 93,576334 

232 846,180848 51,855085 85,236358 

233 2367,906281 77,683587 51,340192 

234 932,811565 43,787607 59,036243 

235 2121,139995 64,04729 15,255119 
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236 1078,071153 45,429236 74,054604 

237 2763,432386 116,791243 75,963757 

238 2395,90813 64,343966 110,854458 

239 4027,015783 128,473799 51,788975 

240 757,800015 35,965987 131,185925 

241 778,801401 47,294172 83,990994 

242 445,404397 27,550223 40,601295 

243 332,521946 23,812548 90 

244 2019,633295 70,336274 64,179008 

245 1211,954989 48,232666 104,931417 

246 301,019867 19,831439 8,130102 

247 233,64042 25,135467 90 

248 721,060278 35,842228 157,750976 

249 272,142961 20,140215 174,289407 

250 2791,784257 77,836465 128,047043 

251 78,405175 10,583355 90 

252 113,092464 17,534384 95,440332 

253 224,014785 26,192466 135 

254 122,289321 18,692226 174,289407 

255 45,940532 9,901346 66,801409 

256 50,534585 7,876221 172,874984 

257 63,911418 9,37138 153,434949 

258 990,565377 38,069288 108,434949 

259 713,172069 37,041741 90 

260 1327,462612 54,526484 77,471192 

261 1614,481556 50,693923 96,340192 

262 200,983265 19,84379 90 

263 1097,217416 46,992001 105,945396 

264 482,191825 25,575983 85,236358 

265 1409,052997 75,366018 52,594643 

266 632,281731 35,646448 6,340192 

267 571,237702 49,391507 45 

268 458,670272 31,133499 78,690068 

269 253,696744 27,465193 14,036243 
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270 9379,856754 250,422871 29,577839 

271 2451,806819 109,706908 29,931512 

272 1643,778489 97,893072 54,107334 

273 1411,468157 67,807681 12,680383 

274 11229,86117 212,913465 85,236358 
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